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Kurzanleitung EndNote 

Installation 

WU Studierende und Mitarbeiter*innen finden im Control Panel (controlpanel.wu.ac.at/de/software) 

einen Link zum Softwaredownload, unter dem das Programm heruntergeladen werden kann. Au-

ßerdem erhalten Sie dort nach Zustimmung zu den Lizenzbedingungen eine Datei mit Lizenzschlüs-

sel (»Product Key«). Installieren Sie das heruntergeladene Programm und kopieren Sie den Lizenz-

schlüssel in das entsprechende Feld, wenn Sie dazu aufgefordert werden. 

EndNote Web 

EndNote bietet zusätzlich zur Desktop-Applikation die Webanwendung EndNote Web unter  

myendnoteweb.com. Sie können dort ein Konto anlegen und Ihre EndNote-Datenbank mit EndNote 

Web synchronisieren. Über diese Web-Datenbank können Sie verschiedene Geräte synchronisieren 

und die Datenbank im Browser auch auf Mobilgeräten benutzen. Eine Web-Datenbank ist die Vo-

raussetzung dafür, Literaturnachweise zu teilen und gemeinsam zu bearbeiten. Richten Sie die Syn-

chronisation unter Preferences » Sync mit den Zugangsdaten Ihres EndNote Web Kontos ein. 

Referenzen verwalten 

Referenzen manuell erstellen 

1. Wählen Sie References » New Reference oder klicken Sie auf das Plus-Icon  oberhalb 

der Literatureinträge. 

2. Wählen Sie den passenden Dokumenttyp: Dieser bestimmt, welche Felder zur Verfügung 

stehen und wie das Zitat und der Bibliografieeintrag formatiert werden.  

3. Befüllen Sie die bibliografischen Felder. Beachten Sie dabei die Formvorschriften für die Ein-

gabe von Namen! Datumsangaben müssen so eingegeben werden, wie sie im Literaturver-

zeichnis aufscheinen sollen. Zeilenumbrüche trennen einzelne Einträge in Namensfeldern, 

sowie in den Feldern URL und Keywords. In allen anderen Fällen werden Zeilenumbrüche 

wie im Eingabefeld gespeichert in das Literaturverzeichnis übernommen! 

Eingabe von Namen 

Namen (in Feldern wie Author, Editor, Series Editor, …) sollten nach dem Schema Nachname(n), Vor-

name(n) eingegeben werden, damit sie je nach Kontext richtig formatiert werden können. Teile vor 

dem Komma werden als Nachnamen, Teile danach als Vornamen sortiert. Adelsprädikate wie von, 

van oder de werden mit den Vornamen angegeben: 

› Judith Butler » Butler, Judith 

› Johann Matthias von der Schulenburg » Schulenburg, Johann-Matthias von der 

Namenszusätze, die immer am Schluss stehen sollen, müssen nach einem zweiten Komma stehen: 

https://controlpanel.wu.ac.at/de/software
https://myendnoteweb.com/
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› George Bush Sr. » Bush, George, Sr. 

Namen von Organisationen, Firmen etc. müssen mit einem Komma am Schluss eingegeben werden: 

› International Monetary Fund » International Monetary Fund, 

Wenn ein Firmenname ein oder mehrere Kommata enthält, muss nach dem ersten ein zweites ein-

gefügt werden, das abschließende Komma entfällt: 

› Ministerium für Wissenschaft, Forschung und Wirtschaft » Ministerium für Wissenschaft,, 

Forschung und Wirtschaft 

Eingabe mehrerer Autor*innen 

Mehrere Autor*innen eines Werks werden im gleichen Ein-

gabefeld aufgeführt. Jede*r Autor*in kommt in eine eigene 

Zeile.  

Referenzen importieren 

Import im RIS-Format 

Das Dateiformat .ris ist ein Austauschformat für Literaturverwaltungsprogramme. Beinahe alle Da-

tenbanken und Bibliothekskataloge bieten einen Export in diesem Format an. EndNote kann diese 

Dateien beim Download direkt öffnen. Alternativ können Sie den Import von EndNote aus durchfüh-

ren: 

1. Klicken Sie auf File » Import » File… 

2. Suchen Sie die Datei auf Ihrem Gerät mit Klick 

auf Choose … 

3. Wählen Sie als Importoption Reference Mana-

ger (RIS) und klicken Sie auf Import.  

Direkter Export nach EndNote Web 

Einige Datenbanken bieten einen direkten Export von Referenzen nach EndNote Web an (z.B. 

EBSCO). Wenn Sie Ihre EndNote-Datenbank mit EndNote Web synchronisieren, können Sie diese 

Option nutzen. 

Recherche in EndNote 

EndNote selbst bietet die Möglichkeit, Datenbanken und Bibliothekskataloge direkt abzufragen. 

Aus technischen Gründen macht das aber oft nur dann Sinn, wenn Sie bereits wissen, was Sie su-

chen: Sie haben beispielsweise bereits ein Dokument vorliegen und möchten dazu die Daten über-

nehmen. Wählen Sie dazu in der linken Spalte eine passende Ressource unter Online Search. Das 

Suchformular oberhalb der Literaturliste zeigt nun die für die Ressource konfigurierten Suchfelder. 

Geben Sie die Suchbegriffe so genau wie möglich ein, sonst erhalten Sie möglicherweise viel zu viele 

Treffer. 

Abbildung 2 Import Optionen RIS-Format 

Abbildung 1 Mehrere Namen 
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Datenbanken oder Bibliothekskataloge für Online Search hinzufügen 

Klicken Sie unter Online Search auf more… und wählen Sie aus der Liste die gewünschte Ressource 

aus. Datenbanken oder Bibliothekskataloge, die nicht von EndNote mitgeliefert wurden, können Sie 

gegebenenfalls mit einem Connection File nachrüsten. Legen Sie dazu die Datei in den dafür vorge-

sehenen Ordner (standardmäßig Dokumente/EndNote/Connections – den tatsächlichen Pfad können 

Sie unter Edit » Preferences » Folder Locations nachsehen bzw. konfigurieren). Die Ressource steht 

sofort zur Verfügung und kann wie oben beschrieben ausgewählt werden. 

Geeignete Ressourcen für die Online-Suche nach Beiträgen 

Bus Source Prem (EBSCO Business Source Premier): Verbindung zum VPN der WU ist notwendig. 

Geeignete Ressourcen für die Online-Suche nach Büchern (insbesondere ISBN-Suche): 

› WU Katalog 

› K10Plus Verbundkatalog (größter deutscher Verbundkatalog) 

› Library of Congress (für englischsprachige Literatur) 

Die Connection files für den WU-Katalog und K10Plus stehen auf library.wu.ac.at/bib/fit4research/in-

dex.php/fit4research-start/literatur-zitieren-verwalten/programme/endnote/ zum Download zur Verfü-

gung. Library of Congress ist direkt in EndNote integriert. 

Gruppen verwalten 

Um Ihre Referenzen zu sortieren, bietet EndNote die Möglichkeit, Gruppen anzulegen: Unter Groups 

» Create Groups oder mit rechtem Mausklick auf My Groups können Sie Gruppen anlegen. 

Um gemeinsam an Literaturnachweisen zu arbeiten, richten Sie zunächst die Synchronisation mit 

EndNote Web ein (s.o.). Legen Sie dann eine Gruppe an, die Sie mit Ihren Kolleg*innen teilen wol-

len. Klicken Sie mit der rechten Maustaste auf den Gruppennamen und wählen Share Group …. Hier 

können Sie die E-Mail-Adressen der Kolleg*innen eingeben, um sie zur Gruppe einzuladen.  

Zitierstile verwalten 

Zitierstile geben vor, wie Zitate im Text und die Bibliografie 

formatiert werden sollen. EndNote liefert von Haus aus eine 

große Zahl an Stilen mit, die im Menü unter Tools » Output 

Styles » Open Style Manager verwaltet werden können. Um 

einen vorhandenen Stil zur Verwendung in EndNote und in 

Cite While Your Write für Word zu aktivieren, markieren Sie 

diesen einfach mit einem Häkchen. 

Für die Masterarbeit im Master Management stehen zwei 

Zitierstile zur Verfügung, die von der Bibliothek gepflegt 

werden. Je nach Sprache, in der die Arbeit verfasst wird, 

Abbildung 3 Style Manager 

https://library.wu.ac.at/bib/fit4research/index.php/fit4research-start/literatur-zitieren-verwalten/programme/endnote/
https://library.wu.ac.at/bib/fit4research/index.php/fit4research-start/literatur-zitieren-verwalten/programme/endnote/


7 
 

wählen Sie auf der Seite library.wu.ac.at/bib/fit4research/index.php/master-management den passen-

den Stildownload auf Deutsch oder Englisch. Legen Sie diese Datei in Ihren Stile-Ordner. Standard-

mäßig finden Sie diesen unter Dokumente\EndNote\Styles – den tatsächlichen Pfad können Sie un-

ter Edit » Preferences » Folder Locations nachsehen bzw. konfigurieren. Sollten Sie einen anderen Zi-

tierstil benötigen, der nicht vorhanden ist, wenden Sie sich bitte an die Bibliothek unter biblio-

thek@wu.ac.at.  

Cite While You Write 

Cite While You Write (CWYW) ist ein Plugin für MS Word unter Windows und Mac OS X, mit dem Sie 

Referenzen aus EndNote einfügen und formatieren und Bibliografien automatisch erstellen können. 

Es wird bei der Installation von EndNote automatisch mitinstalliert. 

Zitierstil festlegen 

Wählen Sie unter Style den gewünschten Zitierstil aus. Es stehen die Stile zur Verfügung, die Sie in 

EndNote aktiviert haben. 

Zitat einfügen 

1. Setzen Sie den Cursor an die Stelle im Text, wo Sie das Zitat einfügen wollen. 

2. Klicken Sie in der EndNote-Symbolleiste auf Insert Citations. 

3. Geben Sie im Suchfenster den/die Autor*in oder Titel der Referenz ein, Sie können hier auch 

gleich mit dem Erscheinungsjahr einschränken. 

4. Wählen Sie die gewünschte Referenz mit Doppelklick zum Einfügen aus. Es wird automa-

tisch gleichzeitig ein Eintrag im Literaturverzeichnis am Ende des Dokuments erstellt. 

Zitat als Fußnote einfügen 

1. Fügen Sie eine Fußnote ein. 

2. Setzen Sie den Cursor in die Fußnote und fahren Sie wie oben unter 3. und 4. beschrieben 

fort. 

Zitate bearbeiten und löschen 

Um Seitenzahlen oder Präfixe wie vgl., siehe etc. 

einzugeben, klicken Sie mit der rechten Maus-

taste auf das Zitat und wählen Sie Edit Citation(s) 

» More. In dem Bearbeitungsfenster können Sie 

unter Edit Citation die Daten eingeben.  

Abbildung 4 Zitat bearbeiten 

https://library.wu.ac.at/bib/fit4research/index.php/master-management/
mailto:bibliothek@wu.ac.at
mailto:bibliothek@wu.ac.at
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Referenz löschen 

Wollen Sie eine Referenz aus dem 

Text löschen, verwenden Sie dazu 

bitte nicht die Löschtasten der Tas-

tatur, da die Zitate sonst durchei-

nandergeraten können. Klicken Sie 

mit der rechten Maustaste auf die 

Referenz und wählen Sie Edit Cita-

tion(s) » More. Im Bearbeitungs-

fenster wählen Sie bei der zu entfernenden Referenz Edit Reference » Remove Citation und bestäti-

gen mit OK (vgl. Abb. unten). 

Referenz updaten 

Wenn Sie eine Referenz in EndNote Web bearbeitet haben, werden diese Änderungen nicht auto-

matisch in bereits bestehenden Zitaten in Ihrem Word-Dokument übernommen. Dazu müssen Sie 

im Bearbeitungsfenster bei der jeweiligen Referenz Edit Reference » Update from My Library wählen 

(s. Abb.) und den Vorgang mit Insert abschließen.  

Sekundärzitat einfügen 

EndNote bietet keine Möglichkeit ein Sekundärzitat automatisch zu formatieren. Da sowohl die Ori-

ginalquelle als auch die Sekundärquelle im Literaturverzeichnis aufscheinen müssen, ist ein bisschen 

Trickserei nötig: 

1. Fügen Sie beide Zitate (original und sekundär) mit EndNote ein, damit beide dann auch im 

Literaturverzeichnis erscheinen. 

2. Schreiben Sie daneben die Zitate als normalen Text in der gewünschten Form. 

3. Verbergen Sie die EndNote-Zitate, indem Sie sie markieren und im Schriftformatierungs-

menü (STRG+D oder rechte Maustaste » Schriftart) bei »Ausgeblendet« ein Häkchen setzen. 

Sie können dann die Zitate beim Bearbeiten weiterhin sehen, sie sind aber im Ausdruck und 

beim Export in PDF nicht mehr sichtbar. 

Prinzipiell sollten Sie Sekundärzitate unbedingt vermeiden und genau nachprüfen, ob das Original 

nicht doch zugänglich ist. 

  

Abbildung 5 Referenz löschen oder updaten 
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Beispiele für Dateneingabe in EndNote 

Abschlussarbeit – nicht publiziert 

 

Audiovisuelle Materialien 

 

Blog 
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Buch gedruckt 

 

Buch elektronisch 
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Buchkapitel / Sammelwerksbeitrag gedruckt 

 

Buchkapitel / Sammelwerksbeitrag elektronisch 
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Herausgeberwerk 

 

KI Tools 

 

Konferenzbeitrag 
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Podcast 

 

Webseite 
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Zeitschriftenaufsatz gedruckt 

 

Zeitschriftenaufsatz elektronisch 
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Zeitungsartikel 

 

 


